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Warum PHP auf i?

Infrastruktur
beibehalten, um Web
Applikationen auf die
einfachste Art zu
entwickeln und
auszufuhren

* Machtig, flexibel, die am starksten wachsende
Web-Sprache

 Nativ auf IBM i/0S durch Zend Server (CE)

» Support durch IBM

* PHP Community

» Easy to Use & Fast to Deploy

» Unterstutzt heterogene Umgebungen

* Machtige Integrations-Fahigkeit

Applikations Zugriff auf RPG Daten konsolidieren in

Modernisierung Programme & Daten mit DB2/400
PHP nutzen um Green Screen Web Services Windows oder Linux Applikation, die
Applikationen web-fahig zu machen; auf die DB2 zugreifen, auf IBM i/0OS
bestehende Daten und Business Logic verlagern, um die Geschwindigkeit zu
nutzen ohne die Applikation neu zu erhohen oder die Komplexitét zu
schreiben verringern

Programme und Daten als
Webservices paketieren und diese
anderen Webapplikationen zur
Verfligung stellen

Zugriff von DB2/400 Daten Neue/Packaged Web
via Browser Applikation auf IBM i/OS

Einfacher Zugriff und Integration mit Neue Applikationen mit PHP erstellen
DB2/400 Daten mit Hilfe eines oder tausende von Open Source
Standard Web-Browsers Applikationen nutzen
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1) Green ins Web

» Green ist gut

» Es ist nichts falsch an einer soliden 5250
Applikation

» Wenn es lauft und die Nutzer produktiv und
zufrieden sind: kein Grund etwas zu andern!

» Sehr gut fur Transaktions-Prozesse
» Herausforderungen

» Kein natives GUI

» Limitierte Anzahl von Farben

» Etwas hohere Lernkurve

» Sieht antiquiert aus, aber stabil!

© All rights reserved. Zend Technologies, Inc.



1) Green ins Web

oIst das Web besser? ==
» Lernkurve der User ist im Web kiirzer
» Technologie ist erwachsen und stabil
» Fast jeder kann einen Browser bedienen
» Kann asthetisch ansprechend sein
»Web 2.0 & HTML5 - Schlielbt die Lucke zum Fat Client

» Der neue Boss hat nie mit einem Textinterface
gearbeitet

...und hat auch nicht vor, jetzt damit anzufangen!
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Allied Beverages

Background

» Exklusiver Vertreiber von Getranken an der US Ost-Kiste

Herausforderung
» Fuhrungsrolle in der Industrie durch Superior Kundenservice steigen
» E-Commerce und mobile Seite etablieren, um die Distribution zu unterstitzen

» Integration mit IBM i

Losung
» Native PHP-Implementierung und gleichzeitigem Nutzen von Legacy Code und Daten

» Nutzen von Web 2.0 und Zend Framework, um eine eBiz Seite aufzubauen

Benefits

» Entwicklungszeit war geringer als veranschlagt und kurzer als die betrachteten Alternativen
» Die Performance von eBiz durch den Einsatz von Zend Server verdoppelt
» Seite gewann 2009 den IBM COMMON Innovation Award

» Keine neue Hardware notwendig

© All rights reserved. Zend Technologies, Inc. "
Zend



2) DB2 Data & Program Accessibility
-Daten sind ein guter Startpunkt %

» Executive Dashboards

» Drill Down Analyse
» Zugriff auf Statistiken und Informationen uber Transaktionen
» Keine Darstellungseinschrankung
» Wie sieht es mit Programmen aus?
» 30+ Jahre Business Logic
» Solide und zuverlassige Routinen

» Durch Stored Procedures konnen Programme wie Daten
angesprochen werden
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Corvette

Corvette America

- Background

» Fuhrender Anbieter fur Corvette Interieur. Anbieter von Ersatzteilen fur
Corvette Handler und Besitzer.

- Herausforderungen

» Verwaltung von effizienten zentralen Operationen, um diese Services
problemlos an ein 3000 Handler zahlendes Netzwerk und eine weltweite
Kundenbasis anbieten zu konnen.

» Mehr Prozesse online, um eine gute Business Experience fur Kunden und Handler
bereitzustellen (Fulfillment Process und Einkauf)

» Losung

» Zend PHP Solutions haben der IT Abteilung von Corvette America geholfen, das
Potenzial der E-Commerce Applikation auf IBM i schnell und kosteneffektiv zu
erweitern

« Benefits

» Nutzen von bestehender Business Logik in Pricing Routinen, ohne die
Notwendigkeit neu implementieren zu mussen

» Ansatz von kollaborativer Entwicklung hat das Teamwork verstarkt

» Der Handler Verkaufsprozess wurde beschleunigt, sowie die Effizienz in der
Verwaltung der Supply Chain gesteigert

8 © All rights reserved. Zend Technologies, Inc.
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3) Web Services...

Was ist das?

» Kleine Programm-Stucke lose gekoppelt...

» Sich selbst beschreibende Programme
kommunizieren miteinander

*B2B Processing und auch B2C
» GPS Karten & Wetter Integration e

» Handelspartner /gd

» Amazon, Yahoo, Google ‘

© All rights reserved. Zend Technologies, Inc. "
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3) Web Services...

«Erweitert DB2 Daten und Programme

Registry.
» Real Time Zugriff auf Inventar @ 5
. Q\ 6//.
» Produkt Details / \

» Legen das Pricing offen

. Requestory i A Provider
o Guter “Gleichmacher” ) 1

» Plattform und Sprache
» Verfugbar ubers Internet und in gesicherten Kanalen

» Vielleicht nutzen Sie sie schon, ohne es zu merken
e Viele Such-Features (wie z.B. im iPhone) benutzen Web Services

© All rights reserved. Zend Technologies, Inc.
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4) Neue Applikationen...
-Pre-Packaged

» Wer schreibt neue Applikationen fur IBM i?

» Welche Sprachen benutzen sie?

» Konsolidierung muss nicht auf Intel-Systemen passieren

» MySQL und PHP erweitern IBM i mit tausenden Applikationen

m Jpenirro
U Thoodle
Magento ¥ Joomlal
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4) Neue Applikationen...

«Home Grown

» Neue Applikation - implementiert auf der grunen Wiese

» Legacy Funktionalitat in neue Applikationen integrieren

e Program Calls
» DB2 Data
» Native IMB i Ressourcen (Data Queues, User Spaces, Spooled Files)
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Arrowcast, Inc. - Supplier Portal

Background

» 20.000 m? groBe GieBerei in Shawano, Wisconsin. Weltweiter Vertrieb von
Gussmetallkomponenten. Vertrage mit der US Regierung, John Deere, Case.

Herausforderungen
» Manueller, zeitaufwandiger Einkauf und Fulfillment Prozess

» Verschiedene Daten (Excel, Access, MSSQL, DB2) auf unterschiedlichen Plattformen
(Windows & IBM i)

Losung

» PHP basiertes Lieferantenportal: Verkaufer loggen sich ein, sehen |hre Stuckliste, die
Sie verkaufen durfen; elektronischer Bestellprozess und Tracking

» Arrowcast konnte Informationen aus Nicht-System i Plattformen und Datenbanken auf
der System i konsolidieren

Benefits

» Lieferantenportal ermoglicht die moderne Arbeit mit Lieferanten, was in hoheren
Ertragen und verbessertem Kundenservice resultiert

» Veroffentlichung von Legacy Informationen an Verkaufer in einem Self-Service-Model
» Steigert die Einsatzmoglichkeiten der existierenden System | Infrastruktur
» Verbesserte Lieferqualitat - Steigerung der punktlichen Lieferungen von 50% auf 90-95%
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5) Daten konsolidieren auf IBM i

« Warum konsolidieren?
» Rock Solid Architektur
» Zugriff via komplett implementierten TCP/IP Stack (IPv4 & IPvé6)
» Reife und dynamische Technologie
» Mit PHP kann praktisch jede Applikation eingesetzt werden
» Kunden bringen die Daten zuruck zu einem zentralen Repository
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Risiken

» “Process Collapse” gilt als der
Nummer 1 Grund von
fehlgeschlagenen Migrationen

» Darin besteht das Risiko

» >60% aller ERP Implementierungen
schlagen fehl (Rockford Consulting,

2010) »
» Moral der Geschichte? =
» Sichergehen, dass Sie und lhr Team Pr
verstehen, warum eine Anderung ——
notwendig ist o

» Dann kann es angegangen werden
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Key Priorities von CTOs und CIOs

» Das Investment in IBM i Infrastruktur nutzen
» DB2/400 Daten via Web zuganglich machen
» Green Screen Applikationen fur End-User webfahig machen
» Nutzen der Power Systems Computing Power maximieren
» Verlagern von Windows/Linux basierten PHP Applikationen auf IBM i
» Neue webbasierte Applikationen einsetzen
« Minimierung der Risiken/Kosten einer Migration

* RPG Programmierer schulen und auf kostengiinstigere
Entwicklungsressourcen zuriickgreifen, um die
Unternehmensanforderungen zu adressieren

- Nutzen der Benefits von Open-Source Technologien

16 © All rights reserved. Zend Technologies, Inc.



Warum PHP?
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Warum PHP auf IBM i?

- Geringe Lernkurve Schnelle

/ Innovationszyklen

Einfache Integration in
heterogene Umgebungen

Agiles
Business
Robust, Multi-Plattform,
High-Performance, skalierbar
Lebhafte Community | Proven
| Deployment

18
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PHP Adoption
Gartner Hype Cycle

Peak of Inflated Expectations

Plateau of Productivity

Slope of Enlightenment

Trough of Disillusionment

Technology Trigger

© All rights reserved. Zend Technologies, Inc. "
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Maturity

« PHP wurde mit einem prozeduralen “Look & Feel”
entwickelt - das gilt auch heute noch

« PHP bietet auch ein Object Orientiertes Model

- Frameworks geschrieben in PHP

» Zend Framework, Symfony, mehr... - 75N\ D

e FRAMEWORK

 Blihende Community
» Millionen Entwickler

» Enterprise wachst rapide (Gartner: 2.5 Million+ bis 2014)
« Tausende Applikationen

» Sourceforge Suche liefert 18,800 Treffer

© All rights reserved. Zend Technologies, Inc.
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Enterprise PHP Adoption wachst rapide

PHP
Developers

5M

aM

3M

2M

1M

2009 2014
Non-commercial developers

. Commercial and corporate IT developers

Gartner Research Note: “PHP: Past, Present and Future”, Dec. 2", 2009

21 © All rights reserved. Zend Technologies, Inc.
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“Commercial and corporate IT
developers will account for more
than 2 million PHP community
members—growing from 20% to
50% of the worldwide PHP
developer population.”
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Top 10 Seiten nach WW Traffic  @)Alexa
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3. Youtube.com 6. Wikipedia.com
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= == 4. Yahoo.com - 9. twitter.com

5. Live.com
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Wie kommen wir dahin?
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Ausbildung

« PHP ist eine der am leichtesten zu erlernenden Sprachen
» ...aber ein bisschen Anstrengung ist notwendig!

- Wie fangen wir an?
» Webinare (Mike Pavlak)
» Web

 Sich informieren...

© All rights reserved. Zend Technologies, Inc.
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Ausbildung

» Was sind die Skills der Entwickler

» Einige sollte mit prozeduraler Programmierung beginnen

» Entwickler mit OO Erfahrung konnen starten

» Entwickler mit guter OO Erfahrung konnen sich Frameworks widmen

« Zend Roadmap fiir PHP

zend
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Ausbildung

IBMi/0S
Programmers

Non

Programmers

e Perl Java C+= VB Saript, ASP Python)

Programmers

‘ 00/Procedural

Core Courses

PHPI: Foundations
for IBMi/OS Programmers

PHP I
Foundations

PHP Ii:
Higher Structures

PHP li:
Higher Structures

Quick Start:
‘ PHP for 00 /Proc Programmers

Building Security
into your PHP Applications

Test Prep:
PHP 5.3 Certification
Zend Framework Courses
Zend Framework: Zend Framework: Test Prep:
Fundamentals Advanced Concepts Zend Framework Certification
Product Courses

Zend Roadmap for PHP

© All rights reserved. Zend Technologies, Inc.
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Ausbildung ‘

« PHP 1: Foundations Training for IBM i Programmer

» Fokus auf fundamentale PHP Konzepten
» Beinhaltet Basic HTML und JavaScript

» Projekt, dass Sie in |hrer Applikation verwenden konnen nach
dem ersten Tag!

» Interaktives Online Training

» Stort nicht wirklich im Alltagsgeschaft
« Zwei Stunden am Tag, jeder zweite Tag, drei Wochen

e Keine Reisekosten

27 © All rights reserved. Zend Technologies, Inc. "
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Ausbildung

* Wie kann man den Erfolg sicherstellen?

» Der Roadmap folgen
» “Soak Time” gut nutzen

» Zeit finden, aber nicht die aktuelle Arbeit falsch
einschatzen

» REALE Aufgaben mit PHP implementieren

© All rights reserved. Zend Technologies, Inc.



Ausbildung

« Konnen RPGler OO und Frameworks lernen?
» Ja klar! Aber...

» Es braucht Zeit, das Material aufzunehmen

» Welcher Lerntyp b
e Denker ._
e Buchliebhaber

e Osmose

29 © All rights reserved. Zend Technologies, Inc.
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Ausbildung

« Osmose oder statistisches Lernen

» OK mit Prozeduralem PHP zu starten

» Man wachst in die OO

» Zend Framework ist komponentenbasiert

» Man lernt OO/Frameworks durch schauen und

probieren

Intraceliular space

TIME N

OCCURS OVER TIME

B WORDY & LWINDS.

© All rights reserved. Zend Technologies, Inc.
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Ausbildung

e lch muss IBM i zum Entwickeln nutzen, richtig?
» Nein, nicht ganz
» PHP hat die gleiche Syntax unabhangig von der Plattform

» Was auf Linux/Windows gelernt wird, kann auf IBM i eingesetzt
werden

31 © All rights reserved. Zend Technologies, Inc. "
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Ausbildung

«iDevCloud.com

» Low Cost Zugriff auf IBM i Ressourcen fur Lernzwecke

» Geteilte oder dedizierte LPARs

» Zend Sponsorship liefert Zend Server in alle Umgebungen!
» Verschiedene OS Level

» Expert System Management

» Artikel bei IT Jungle IT

e http://www.itjungle.com/fhs/fhs081010-story01.html

© All rights reserved. Zend Technologies, Inc.
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Beispiel
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Eine Ausrede finden, um mit PHP zu spielen

Interne IT Applikation

» Chef fragt schon eine ganze Weile nach IBM i spezifischen
Informationen

» (hauptsachlich) System-Werte
« PHP Skript, das die wichtigen Infos auf Mausklick anzeigt
« Andere Ideen:

» Helpdesk Automatisierung von Green Screen Tasks
» RPG Reports ins Web

© All rights reserved. Zend Technologies, Inc. "
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System Value Code #1

<?php

include 'i5db2connectonly.php’';

$gmodel = 15 get system value ('QMODEL');
$gsrlnbr = 15 get system value ('QSRLNBR') ;
$qautocfg = 15 get system value ('QAUTOCFEG');
i5 close(Sconn) ;

?>_

<html>

<head><title>Customer Insert</title></head>

<body>
<hl>Main Computer Information</hl>

35 Insert->Header & Footer © All rights reserved. Zend Technologies, Inc. "
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System Value Code #2
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System Value Code #3

<tr>
<td>Serial</td>
<td><?php echo $gsrlnbr; ?></td>
</tr>
<tr>
<td>Serial</td>
<?php if ($qautocfg == 1) :?>
<td>0On</td>
<?php else : ?>
<td>0ff</td>
<?php endif; ?>
</tr>
</table>

</body>
</html>

Insert->Header & Footer © All rights reserved. Zend Technologies, Inc.
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System Values Output

/[ Customer Insert

= C' | ® http://cuperl.zend.com/jan/COMMOMSysVals.php

Main Computer Information

Description System Value

Model 520

Serial 10B95CE

Processor Feature Code 7736

Date 11-03-10

Time 10:22:53

Code Character SetlD 37

Controlling Subsystem QBASE QSYS

Start Up Program QSTRUP QSYS

Minimum Password Length

Maximum Password Length

Auto Config

© All rights reserved. Zend Technologies, Inc.
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Wrap up
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Ressourcen

» Aufgezeichnete Webinare

» http://www.zend.com/en/resources/webinars/IBM i-0s

« Zend Server for IBM i Hauptseite, Link zu Downloads

» http://www.zend.com/en/products/server/zend-server-ibm-i

« Zend Server Anleitungen:

» PDF: http://www.zend.com/topics/Zend-Server-5-for-IBMi-Reference-Manual.pdf

» Online: http://files.zend.com/help/Zend-Server-5/zend-
server.htm#installation guide.htm

© All rights reserved. Zend Technologies, Inc.
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Dankeschon!

jan@zend.com
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